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David’s BackGammon

David’s BackGammon
Features:

· Play against the Computer
· Play against another person
· 5 skill levels 
· Fast Computer Play
· Piece movement is animated - don’t just appear in the new location
· Utilizes mouse or keyboard for easy play
· Can pick up more than 1 piece at once (up to 4 if doubles) for faster and more realistic play
· Take back moves and cube doubles all the way to the start of the game
· Speech if you have SAPI compliant text-to-speech software installed
· Digitized sound effects
· Cube can be used in all modes of play
· Recommends “best” moves
· Gives Doubling Cube Advice
· Save your game to finish later
· Switch board direction and colors
· Setup any board situation.
· On-line Help
· Context sensitive help
· Helpful messages during play using speech & text
· Tournament Play
· Print the entire game
· Selectable board sizes
· Multiple board color schemes
· Hot key to hide the game quickly (in case your boss shows up)
· Add comments when saving a game for later recall
· Concede/resign games
· Option to roll real dice then input the results
· Create custom board colors
· Change the speed of piece movement
· Select the number of automatic doubles
· Beaver option supported
· Jacoby rule optional
· Option to allow one roll-over during the game
· Option to re-roll first roll
· Option to not allow backgammon
· Option to have winner roll first
· Option to make sure you get the first roll
· Option to make sure you get a good first roll
· Option to force the computer to accept all of your cube doubles
· Easily (1 click) display pipcounts or remaining rolls for both players
· Note pad for taking notes during play
· Automatic Rolls of the dice for faster play
· Choice of shorter dice sound for faster play
· Keeps track of statistics for up to 4 pairs of players
· Instant replay of computer’s last move
· Option to show possible moves when a piece is picked up
· Display the risk of you blots being hit
· Option to speak the dice rolls
· Can replay the game using the same dice rolls - using either yours or the computer’s rolls
· Can continue a game after it has ended due to the cube being declined or a concession
· Keeps game and session statistics as well as running/cumulative statistics
· Plus many more play options
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David’s BackGammon

Introduction

Welcome to David’s BackGammon. With 5 levels of play, the game should be enjoyable for all level 
of players. David’s BackGammon was originally created to provide a highly skilled opponent for the 
serious backgammon player when a willing and able human partner is not available.  From my own 
experience this is most of the time. With the 5 levels of play even the beginner can now enjoy 
playing.

You can also play with another person sharing a mouse. Whichever way you play the game, I am 
sure you will find the game enjoyable.

Getting Help

David’s Backgammon was designed to appear as simple as possible to play but at the same time be 
the most sophisticated backgammon game available. The result is that many of the  features are not 
obvious at first. 

It is strongly recommended that you examine the menu items and use the Help system. At minimum 
read the Quick Play Instructions in Contents under the Help menu. The on-line Help system 
contains the information in this manual plus it is easier to use.  

At any time you can click the right mouse button for help in your current situation.

System Requirements

You will need Windows 95 or later. A sound board is recommended. Speech can be used if you have 
SAPI compliant speech-to-text software installed.  Monologue for Windows (32 bit version) is 
available at many computer stores.

Getting Started

It is strongly suggested that you install the game on your hard disk; playing it from the hard drive 
rather than from the floppy. 

To install the game on your hard disk, if you have Windows 95, use the procedure for Adding 
programs by selecting Start then Settings then Control Panel then double click on Add/Remove 
Programs. Insert the game disk in the floppy drive then select Install in the Add/Remove Programs 
dialog. Follow the instructions.

Once installation is complete, you should be able to start the game using Start/Programs/David’s 
BackGammon. If for some reason the game does not appear there you can start the game by double-
clicking on the David’s BackGammon icon or dgammon.exe.

Quick Play Instructions

Note: click means pressing the left mouse button once.
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The arrow in the upper right corner gives your piece color and direction of play.

Your dice are on the right and your tray is on the bottom.

Roll the dice by clicking on one of the dice (actually anywhere in the board except for over BAR)
Select the piece to move by clicking on the piece (don’t hold the mouse button down)
Select the destination by clicking on the row you want your piece on (not over a piece)
Double your opponent by clicking on the Cube
Bear-off a piece by putting it in your tray (tray with the same piece color at the end)
Take back a move by clicking on the word BAR or by selecting the last piece moved and putting it 
back. You can also use Ctrl-Z.
De-Select a piece by clicking on the row the piece came from or click on the word BAR 

Can’t use both dice - click on the dice to continue play

Forgot where the piece came from -  click on the BAR 

Select Show Possible Moves to have the game show which moves are possible when a piece is 
selected. It also shows where the piece, that is selected, came from.

Get context sensitive help by clicking the right mouse button or the F1 key.

Want Information—Run the cursor over the bottom section of the board frame. Click when the 
cursor turns to the appropriate letter. P for Pip Count, R for Remaining Rolls, etc....  Reference 
Helpful Information

Note: You can pick up more than 1 piece at once if  “Pick Up Only 1 Piece” is not selected in the 
Board menu.

Playing Against the Computer

If you don’t know how to play backgammon you should read a book on basic game play before 
starting. At minimum, you should read the basic backgammon rules provided in the appendix. 

When you start the game it is set to play a at the highest skill level.  If you are a beginner you might 
want to change the skill level to a lower skill level by using the Skill menu and turn off the Cube 
Used option in the Options menu.

You might want to look at the Quick Play Instructions in the Appendix for a quick summary of 
play.

Note:  Click is short for press on the left mouse button once.

To get help click on the right mouse button, or select a help item from the Help menu.

To get started, just click on one of the blank dice and play.
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When the game starts, an arrow appears in one of the top corners indicating your direction of play and
piece color.  In the bottom corner is a piece of the same color at the end of your tray.  This is where 
your pieces are placed when you bear off the board. Your dice are on the right.

General Game Play

This section applies to all modes of play.

Handy Tip - Try this. Press the ESCape key. This hides the game. the Task Bar to bring it back. 
This could come in handy when your boss walks up.

If you win the first roll, to move a piece, just select the piece you want to move by clicking on the 
piece (don’t hold the mouse button down).  The mouse pointer changes to the piece selected.  Move 
the piece, by moving the mouse, to the row you want to put the piece on (not over a piece), then click 
again.  It’s just that simple.  The selected piece will move onto the new row (unless you made an 
illegal move).  See below for selecting more than 1 piece at a time.

Note: You can put a piece down over another piece if it is over the next available slot.

To de-select a piece, click on the row it came from or click on the word BAR in the center of the 
board.  When de-selecting a piece by clicking on the row it came from, the center of the selected 
piece must be over a part of the row with no piece, otherwise it will think you are trying to select 
another piece.  Once a piece is selected, the only activity you can perform is to move the piece to 
another row, de-select the piece or select another piece.

You can take back a move by picking up the piece and putting it back on the row it came from or by
clicking on the word BAR after a piece has been moved.  See the next section for a more complete 
explanation.  

If you weren’t lucky enough to win the first roll, then your computer will make its move.   After it 
moves, 2 blank dice will appear on right side of the board.  Just click once on one of the dice,  then 
make your move. (anywhere in the dice area will work)

If you can’t use one or both dice, click on the dice to pass play to your opponent.

You can select more than 1 piece at a time by moving the selected piece (pointer) directly over 
another piece, then select it. 

Taking Back Moves

If you just put the piece down you can put it back by picking up the piece and putting it back on the 
row it came from. If you still have a piece selected, de-select it before picking up the piece to put it 
back.

If more than 1 piece has been moved (doubles were rolled) you can move them back one at a time by 
putting them back in reverse order. 

You can also take back the pieces moved this roll by clicking on the word BAR or pressing Ctrl-Z.
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Clicking on BAR gives different results depending on the situation.  In all situations the same rolls of 
the dice are repeated for the moves that were taken back (sorry). You can get around this by inputting
the roll using the Input Rolls option under the Board menu  

- blank dice are showing - this either takes you back one computer move and one of your moves or, 
if you just doubled your opponent, it will take the double back. 

- both dice are showing, none used - shows the blank dice again.

 - one or more dice used - takes you back to the beginning of your move with dice showing.

- a piece is selected - puts the piece back where it came from.
 

Doubling Cube

To use the doubling cube the Cube Used option must be selected in the Options menu.  If the option 
is selected the cube appears in the middle of the board on the end opposite the piece trays.  At the 
beginning of the game the cube shows the side with a 64.  Since the cube does not have a 1, the side 
with 64 is displayed to represent a 1. 
   
You can double your opponent by clicking once on the cube.  If you are playing against the computer,
it will let you know its decision.  If you are playing with another person they are asked if they will 
accept a double.  If you are doubled, just answer the question by clicking on the appropriate answer.

Bearing pieces off the board

Bearing a piece off the board is easy.  The destination is the tray, at the side of the board, which has a 
piece the same color as your piece color.  Just select the piece to bear-off, then click on your tray.  
The piece is placed in the tray. See, I said it would be easy.

For a more complete explanation of the various game options, read the Menu Summary section.  To 
fully enjoy and understand David’s Backgammon, it is recommended that you read the rest of your 
manual.  

End of Game Options

At the end of the game a dialog appears that tells you who won how may points, games statistics, and 
some options:

New Game - start a new game

Quit - quit the game

Print Game - print the details of the game just finished

Replay With Same Dice - start a new game using the same dice rolls as the game just completed.

Replay With Same Dice Swapped - start a new game using the same dice rolls as the game just 
completed, however you use the computer’s rolls and the computer uses yours.
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Continue Playing the Game - If the game ended due to a doubling of the cube being declined or a 
concession, you can continue playing the same game by selecting this option. The game is scored as 
if it ended at this point. There is no score for the continued game. Note: after the game continues, if 
either player declines another double of the cube or concedes, a new game is started.

Playing With Another Person

First read the Playing Against The Computer and General Game Play sections.

When the Human Opponent option is selected, the first thing you must do is enter both of your 
names.  Decide who is going to roll the dice on the left side of the board and who will roll on the 
right side, then when requested, enter your names.  When it is your turn to play, your name will 
appear at the top of the board . 

Tournament Play

In tournament play you play a tournament against the computer. When you select Start Tournament 
from the Game menu you are presented a dialog box where you can enter:

1. The number of points required to win the tournament.
2. Whether the Crawford rule is in effect. The Crawford rule forbids a doubling of the cube  for one 

game after an opponent wins a game that puts him within 1 point of winning.
3. The starting scores of both players. 

When Start Tournament is selected  the following options are deselected if they were selected. 

Beaver Allowed is turned off
Jacoby Rule is turned off
Who Gets First Roll is set to Random
Roll Over is turned off
Re-Roll First Roll is turned off
Computer Accepts All Doubles is turned off

Even though they are deselected when Start Tournament is selected they can be selected again to be
used during tournament play.

When End Tournament is selected these options are set back to what they were before Start 
Tournament was selected.

When a game is saved during tournament play appropriate information is saved to restart the 
tournament later. 

Your can get the points won for each player by selecting Tournament Stats in the Stats menu.

Getting Help and Information

There are several ways to get help:

1- this manual is your best source of help,
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2- the Help menu provides Help on most subjects 
3- clicking the right mouse button or clicking on the arrow in the upper corner of the screen, 

pressing the F1 key, or pressing on the Help key will give help for the particular situation you are
in at the time. (either corner will give help)

4- use the keyboard by pressing these keys to get the information or move the mouse along the 
bottom board frame then click when the cursor turns into the appropriate letter or select it from 
the CursorOptions menu :

I...........Instant Replay of the computer’s last move
P..........Pipcount (see the glossary)
R.........Remaining Rolls (see the glossary)
W.........Who is winning - a good assessment but is not always accurate
S..........Show Best Moves
M........Make Best Move
D.........Doubling Advice
B..........Display your Blot Risk
C.........Show Best Computer Moves
N.........Note Pad
H.........Help (same as Help key and click on Arrow) 
E..........Enter a message (only with the keyboard in Modem Play - Not Available in this version)

5- Move the cursor in between the trays until it becomes a P, then click to display the pipcount for 
each player. Click again, when the cursor is an S, to change back to a display of the score for each
player.

Below is an explanation of some of the help items.

Show Best Moves

Displays the 3 “Best” moves.   The moves are displayed in board rows of 1 through 24, starting with 
24, in the upper left hand corner, moving clockwise with 1 in the bottom left.  

Note:  If you reversed the direction of play, 24 will be in the upper right moving counter clockwise, 
with 1 being in the lower right.

You can use the Show Row Numbers option to display the row numbers, however, it can not be 
selected while the Best Moves are being displayed.  

The Bar is designated as a B in the “from” position (first character).

Bearing a piece off the board is designated by a B in the “to” position (after the “-“).

This might seem confusing but it’s really simple.  Just try it.

Note:  Can only be selected before the first die for a roll is used.

Can also be selected by pressing on the S key or by clicking when the cursor becomes a S when 
moved over the bottom of the board frame (on the right side).
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Make Best Move

Moves the pieces for the “best” move.  After the move is made, you have the option of using the 
move or taking the move back.  The “best” move is the same as the first of the 3 “best” from the 
Show Best Moves option.

Can also be selected by pressing on the M key or by clicking when the cursor becomes a M when 
moved over the bottom of the board frame (Center).

Doubling Advice

When it’s your turn advises if doubling your opponent should be considered.

When you are being asked to accept or decline a double from your opponent, advises on whether to 
accept or decline the double.

Can also be selected by pressing on the D key or by clicking when the cursor becomes a D when 
moved over the bottom of the board frame (on the left side).

Show Best Computer Moves

Displays the computers “best” 3 moves for the computer’s last move.  
Can also be selected by pressing on the C key or by clicking when the cursor becomes a C when 
moved over the bottom of the board frame (on the left side).

Note:  Can only be selected before the first die is used and before the Show Best Moves is selected.  
Can be selected when your dice are showing.

Note:  The “best” move might not be the one actually used by the computer. It will be the same if the 
game is set to the Club Champ skill level.

Note Pad

A scratch pad that can be used to make notes during game play.  When the Note Pad window is 
closed the contents are saved to disk.  The Note Pad can be selected 2 ways; by pressing  the N key, 
or by clicking when the cursor turns to an N when passed over the appropriate area in the lower frame
of the board(Information Line).

Keyboard Input

All play can be done using the numeric keypad. First select ‘Show Row Numbers’ from the Options 
menu. 

To roll the dice press the  +  key

To make a move enter the FROM ROW number, then a PERIOD, then the DISTANCE to move, 
then press the ENTER key.   e.g.  13.8[ENTER key] would move from the 13 row to the 5 row.

25  is for the BAR row
· - is the same as clicking on BAR (take back move or double of the cube)
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· * is the same as clicking on the Cube for doubling
· + is the same as selecting YES
· - is the same as selecting NO
·
ENTER key alone repeats the last FROM row using a remaing die.

Enter incorrectly? Just press the ENTER key. Then enter the whole move again.

Just entering the FROM row then pressing the ENTER key will show the possible moves for the 
piece. Then enter your move as you would normally.

Changing Board Size

The board can be set to different sizes by selecting Board Size in the Board menu.
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MENU SUMMARY

File Menu

Hide/Resume Game

During play the game can be hidden in a hurry (if your boss is coming) by pressing on the Escape key
or by selecting this menu item.  The game is not affected.  To bring the game back into view press 
Alt-Tab keys.

Load Game...

Loads a previously saved game. Play is resumed at the place the game was saved. If a comment was 
entered when the game was saved it will be displayed when the game is loaded.

Save Game ...

Saves the current game allowing the game to be loaded and resumed at a later time. Allows the game 
to be saved using any name. A comment can be entered when the game is saved. When the game is 
loaded later the comment will be displayed. 

To save a complete game select either Save Game option when you are being asked if you want to 
play another game.

Print Game...

Use this to print a history of the currently displayed game. If you want to print a complete game 
select this when you are being asked if you want to play another game.

Quit Game

Game Menu

New Game

Ends the current game, starting a new game. The scores are not reset.

New Session

The same as the New Game selection except the scores are reset.

Start/End Tournament

Use this to start a tournament. See the section on Tournament Play for an explanation of tournament 
play.

Money Session
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In a Money Session the money won by each player is remembered until the Money Session is ended. 
A Money Session can last for as long as you want it to. 

Instead of the points won being displayed between the 2 trays, the amount of money won or lost by 
each player is displayed.

To start a Money Session select "Start Money Session" in the Game menu. To end the Money Session
select "End Money Session" in the Game menu.

Currently the wager for each game is $1 for each point won. Look for improvements/enhancements in
the features for a Money Session in the near future.

Concede/Resign...

Allows the player to concede the game.  The number of points lost will depend on the value of the 
cube and the board situation at the time of the concession. You will be asked if you accept the loss 
and the number of points that you will loose. If you accept you will loose the points displayed. If you 
don’t accept the game will continue.  In modem play... 

Computer Opponent

This is the default mode of play.  You will be playing against the computer.

Human Opponent

This mode allows you to play with another person on the same computer.  Play is similar to playing 
against the computer except that you share the mouse and the person on the left plays the direction the
computer would play.

Quit 

Exits the game. Gives you the option of saving the current game before exiting.

Board menu

Show Row Numbers

If you are not sure what the row numbers are, this puts the row numbers 1 - 24 on the board. This is 
helpful when using the keyboard to input rolls or when viewing “Best Moves”. Can not be selected 
when any other message is being displayed over the board. Select again to take the row numbers off 
the board.

Pick Up Only 1 Piece

When selected, you can only have one piece picked up at a time. If it is not selected you can have as 
many pieces picked up as there are moves to make (up to 4 with doubles).
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Each method has its advantage and disadvantages. 

When selected, it is easier to put a piece down but you can only pick up one piece at a time.

When not selected, you can pick up more than one piece. This makes game play much faster and 
more natural. However, until you learn how to use it correctly it can be more difficult to put a piece 
down.

It is recommended that you learn how to use the game without this option selected.

Sound...

This brings up the Sound Control dialog box. You can turn sounds on or off for the dice roll and the 
piece movement during game play. You can turn the dice sound off separately and select either a long
or short dice sound. This causes sampled sounds for the dice roll and the piece movement to be turned
on or off during game play.

Speech…

Any messages displayed on the message line, at the top of the board, are spoken by the built-in 
speech facility.  Speech is especially useful during modem play. See the Appendix for more 
information on the speech facilities.

Input Rolls

This allows you to use your own dice, if you don’t trust the computer, and input the results.  Doesn’t 
make much sense to me. (see Choose Dice in the Board Setup Section)

Automatic Rolls

When selected the dice are rolled automatically. This allows game play to go faster. 
It can only be used when the cube is not being used, otherwise you would not have a chance to double
your opponent.

You will need to click to roll the dice in the first game.

Automatic Pass

When selected the play is automatically passed to your opponent when you can not make any moves. 
The message “You can’t make any moves” is displayed.

Switch Direction

Switches the direction of play. Moves the piece trays to the other end of  the board, changes the 
direction of play and reverses the pieces appropriately. You should switch direction and colors once 
in a while so you don’t get fixed on one color and direction. When you play with other people (or 
games) you don’t always get the direction or color you want.

Switch Piece Colors
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Swaps your piece color with your opponents.

Show Possible Moves 

When a piece is picked up an X is placed next to the rows that it can be moved to. An O is displayed 
next to the row that the piece was picked up from. This only works when 1 piece is selected.

Switch Sides

This option, when selected, will switch your pieces and your cube with your opponents.  It is like 
switching sides of the board. You could back up the moves all the way to the beginning of the game 
so that you could re-play with the rolls of the dice that your opponent received to see if you would do 
better or worse.  

Of course you do have the advantage of having seen the rolls before.

Setup Board

This allows you to set up any board situation you want by placing pieces where you want them, 
selecting the dice to be rolled, choosing who is to get the roll, and selecting who has the cube.  See 
the section on Board Setup section in the Appendix.

Setup(Clear) Board

This is the same as the Setup Board option except it clears the board of all pieces.  In most situations 
it is easier to clear the board when setting up a special situation.

Piece Shape

Changes the piece shape from round to square and several steps between

Piece Speed

Adjusts the speed of piece movement. 

Board Size

Select from several board sizes, with 1 being the smallest.

Fit Window To Board

The David’s Backgammon window is made to be just larger than the backgammon board. 

Click After Move…

Selecting this will give you the choice of selecting the option to click after the move before play is 
passed to the other player. You can select it for your moves or the computer’s moves.

After your move, this allows you to take back your moves by clicking on BAR.
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Display 4 Dice on Doubles

Four dice are displayed when doubles are rolled, otherwise 2 are displayed.

Redraw Board

Shouldn’t ever be needed. Select this to redraw the board in the event the board gets messed up.

Board Color

You can select either one of the built in board colors or select a custom color that you have created. 
See Custom Board Colors in the appendix.

Options menu

Cube Used

Allows the cube to be used to during play, if selected.

Cube Maximum Value

Select the maximum that the cube can be during game play.

Automatic Doubles

Selects the number of automatic doubles allowed on the first roll. The cube is doubled automatically 
if both players roll the same die on the opening roll up the number selected times. 

Beaver Allowed

This option allows the doubled player to double the cube immediately after being doubled and still 
retain the cube.  The player must make the double before the other player rolls his dice.
You are given 3 seconds to make the choice to Beaver after the computer has doubled you and you 
have accepted its double.

Note:  The 3 second waiting period could be noticeable during play.

Jacoby Rule

A double or triple game is not allowed unless the cube was passed at least once during the game.

Computer Accepts All  Doubles

If selected, the computer accepts any double from you.  It tells you if it would not have accepted the 
double.

Roll-Over
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Allows you to roll your dice over one time during the game or have your opponent re-roll. An R, in 
your piece color, will show in the middle of the top of the board when the option is selected. The R 
will be displayed until the “roll over” is used. To roll over click on the R. 

To take back an opponent’s roll, your opponent must first complete his move.

Roll Overs are final. You can not regain the ability to cause a roll over by taking back moves to or 
past the point of a roll over.

No Backgammons 

If selected backgammons are not allowed. A backgammon will be treated as a gammon.
Re-roll First Roll

With this selected the winner of the first roll is permitted to accept the roll as is or to re-roll his dice 
and use the new roll (even if it is a worse roll). 

Re-roll First Roll

With this selected, the winner of the first roll is permitted to accept the roll as is or to re-roll his dice 
and use the new roll (even if it is a worse roll).

Who Gets First Roll…

You can select how the first roll of each game is determined:

Random - the player with the highest randomly selected die moves first. 

Winner of Previous Game - the first game uses the Random method mentioned above. After 
the first game the winner of the previous game rolls first in the new game.

Human Player - You win the first roll

Human Player With Good Roll - You not only win the first roll but you get one of the better
first rolls also.

Computer Player - The computer gets the first roll

Automatic Concessions.

During game play if the computer determines that it has lost the game it will offer a concession. If 
you accept you will win the game for the number of points offered, otherwise the game will continue.
The computer will only concede if it is a running game. 

CursorOptions menu

This menu was added for those that didn’t read the help information that explained how to get the 
same information by clicking the left mouse button at the appropriate time.

David’s BackGammon -18- 4/18/2021



David’s BackGammon

See Getting Help and Information above for an explanation.

Skill menu

There are five skill levels.  Just try them to see what suits you.  Club Champ should give the toughest 
game.

Stats Menu

Enter Name(s)

Enter your name for play against the computer or input or change the names that are used in Human 
Opponent play.

Game Stats - displays statistics for the current game.

Session Stats - displays statistics for the current session.

Tournament Stats - this displays a dialog that contains the points won for each play.
 
Running Scores

This brings up the Running Scores dialog box.  This is a multi-function dialog box:

· Displays statistics for each set of players
· Names can be entered
· Statistics can be reset to zero for each set of players

Unless you never play against the Computer I recommend that you leave the left player as the 
computer for the first set of players.

Each time a different set of players is playing the active players must be changed so the statistics are 
accumulated for the correct players. Under the On column on the far left select the appropriate 
players.

The statistics for each set of players is kept until they are reset.

The statistics are, for the most part,  self explanatory.  Points and Games Won are not the same thing. 
Points take into account gammons, backgammons and the doubling cube.

Select “More Scores” to get statistics on more aspects of game play.

Help Menu

Gives information that helps you play the game.

About David’s BackGammon

Gives creator and version.
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Registration Items

These menu items are used to obtain information on registering/ordering the game.
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Appendix

Speech Facilities

When selected, any  messages displayed on the message line, at the top of the board, are spoken.

To use the speech option you must have SAPI compliant speech software installed on your system.

First Byte has speech software call Monologue 97 that can be used with the game. Some speech 
recognition software now has SAPI compliant text-to-speech software included. 

You can check out Monologue 97 and First Byte at this URL:

www.firstbyte.davd.com/html/monolog.htm

Custom Board Colors

You can change the board colors by creating a custom color file.

Use a text editor such as NotePad to create a custom color file. Below is an example file.

BORDERCOLOR 25 90 85
BOARDFRAMECOLOR 000 50 100
BOARDFIELDCOLOR 50 130 70
DARKROWCOLOR 0 50 100 
LITEROWCOLOR 0 90 160
DARKPIECECOLOR 180 60 60
LITEPIECECOLOR 220 220 000

The numbers are RGB color values(Red Green Blue). They vary from 0 to the least amount of the 
color to 255 which is the most amount of the color. Some of the most common colors are:

red  255 0 0  
green 0 255 0
blue   0 0 255
yellow 255 255 0

The words must be spelled correctly and at least one space between each item.

Save the file with any name you like with a .col extension. e.g. Green.col. The file must be a text file!

If you leave out BORDERCOLOR  the border will be marble like.

Board Setup

By selecting either the Setup Board option or the Setup(Clear) Board option from the Option menu 
you are able to setup any board situation that you want. Setup Board leaves the pieces where they 
were, Setup(Clear)Clear Board puts all of the pieces in the trays.
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Board Setup

After selecting either of these options, move the pieces around as you like by picking them up and 
putting them down on the desired rows. 

Pieces can be taken out of the trays by placing the hand (thumb) over any of the pieces, then clicking.
A piece can be put back by placing the hand (thumb) over an empty part of the tray.

When you are finished click on Done. This takes you to Cube selection.

Cube Selection 

First select the value of the Cube.  It starts at 1.  This places the cube in the center as it is at the start 
of a game.  Click on the number to increase the cube value.  When the cube value is correct, click on 
the color of the “owner” of the cube.  This takes you to Whose Roll selection.

Whose Roll 

Click on the color of the player who moves next.

Choose Dice 

You can either select the dice to be rolled or leave it to chance.  To select the dice just click on the 
dice you want.  To leave it to chance, click on No

Now play as you would in normal game play.
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Basic Backgammon Rules

Reference a book on backgammon or a book of game rules.

Objective

The objective of the game is to bear off all of your pieces from the board before your opponent does, 
or if using a doubling cube, to force the other player to lose by declining a double of the cube.

Piece Movement

1. Direction of play is from your opponent’s inner board to your inner board.  When the game starts,
an arrow in one of the upper corners indicates your direction of play and piece color.  You bear 
off your pieces from your inner board, at the bottom of the board, into your tray.

2. Play of the pieces is governed by two dice, thrown onto the board. One move for each die.  If both
dice are the same (doubles), then play consists of four moves of the number thrown.  

3. The first play goes to the player making the highest opening throw.  The opening throw is made 
with each player throwing a single die, with the winner using the number on both his own and his 
opponent’s die for the first play.

4. The play of the pieces consists of:

a. Moving a piece the exact number of points indicated by the number of pips on a die.  
Either one piece can be moved using both die or by moving two different pieces.

b. Bearing off a piece from your inner board.  This can only be done if you have no pieces 
outside of your inner board or on the Bar.

5. No play can be made that lands on a row occupied by two or more of your opponents men.

6. When your play lands on a row occupied by a single piece (blot) of your opponent,  the blot is 
“hit” and is put on the Bar for entry into your inner board.

7. A player having a piece on the Bar may not play other pieces until that piece has been entered 
from the Bar.  A piece is entered from the Bar into your opponents inner board.

8. Plays must be made for both dice if possible. Either number may be played first.  If only one 
number can be played, and there is a choice, the higher must be played.

Bearing Off

For this discussion of bearing off, the row numbers are the same as the minimum number of pips 
required to bear off, 1 through 6.

1. As soon as a player has moved all of his pieces into his inner board, he may start bearing off
his pieces.

2. You can bear off only if you have no pieces outside of your inner board or on the Bar.
3. A piece may be borne off a row of the same number as appears on the die.
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4. A piece may be borne off from the highest occupied row if it requires less than the number on the 
die to bear off the board. 

5. If a number is thrown for an unoccupied row, no piece below can be borne off, for that die, while 
any piece remains on a higher row.

Scoring

1. A Single game is won by the first player who bears off all his pieces.

2. A Double game is called a Gammon and is won by the player who has borne off all his pieces 
before his opponent has removed a piece. 

3. A Triple game is called a Backgammon and is won by the player who succeeds in bearing off all
his pieces before his opponent has borne off a piece, and still has pieces in the winner’s inner 
board or on the Bar.

Doubling Cube

The doubling cube allows the stakes to be doubled during game play by the player that “owns”  the 
cube, or by either player the first time it is used.

The cube starts in the middle of the board with the side with 64 facing up, being “owned” by neither 
player. 

When either player wishes to double the stakes during game play, he places the side up that doubles 
the bet and places it on the opponents side of the board.  If the double is accepted by the other player 
then the stakes have been doubled with the other player “owning” the cube, being the only one that 
can next redouble.  If he declines then the game ends immediately with the value of the cube being 
what it was before the double.
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Glossary

Automatic double   an option where the cube is doubled automatically if both players roll the same 
die on the opening roll of the game.

Back Game  a strategy used when a player finds himself significantly behind in the game.

Backgammon   in addition to the name of the game, it is also the result of a game in which one 
player removes all of his pieces before the other player has removed any pieces and has a piece in the 
opponents inner board or on the Bar.  This results in a triple game (worth 3 times as much.)

Back Men/Pieces  the two pieces that are farthest out at the start of the game (opponent’s 1 point). 
Also called Runners.

Bar   the center divider separating the inner and outer boards.  Hit pieces (blots) are placed on the bar
until the piece is re-entered.

Bar Point  the 7 point. A strategic blocking point.

Bearing off   the process of removing men from the board.

Beaver   an optional rule where the doubled player can re-double the cube after being doubled.  The 
double must be made before the other player rolls the dice.  When playing against the computer you 
have 3 seconds to re-double. 

Block  a series of contiguous points that block your opponent from advancing his back men

Blocking Game  a strategy where the goal is to block your opponent’s back men in your home board.
The best overall game strategy.

Blot   a single piece on a point.   A blot can be hit by an opposing piece and placed on the Bar. 

Builder a piece that can be used later to make important points later in your inner board or as part of 
a Block. 

Cube   the doubling cube.  The cube is die shaped with the numbers 2, 4, 8, 16, 32, 64 printed on the 
6 sides.  The cube allows the stakes to be doubled during game play by the player that “owns”  the 
cube.  The cube starts in the middle of the board with the side with 64 facing up, being “owned” by 
neither player.  When either player wishes to double the stakes of the game during game play, he 
places the side up that doubles the bet and places it on the opponent’s side of the board.  If the double 
is accepted by the other player, then the stakes have been doubled with the other player “owning” the 
cube, being the only one that can next redouble.  If he declines, then the game ends immediately with 
the value of the cube being what it was before the double.

Double   See Cube. 

Double Game  See Gammon

Doubling Cube   See Cube.
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Gammon   A game in which one player removes all of his pieces before the opponent has removed 
any pieces from the board.  This results in a double game (worth twice as much).

Home Board  your inner board

Inner Board  the quarter of the board where you must move all of your pieces before bearing off.

Outer Board   the quarter of the board adjacent to the Inner Board.
 
Pips   The dots that appear on the face of the die.

Pip Count   The minimum number of pips required to move all of a player’s pieces off the board 
(assuming no blots are hit.)  Can be displayed by pressing on the P key or by clicking 
when the cursor becomes a P when moved over the bottom of the board frame (on the right

side).

Prime  Six consecutive points you have made.

Remaining Rolls  the approximate number of rolls required to bearoff all of their pieces. During the 
later stages of a running game this gives a more accurate assessment of the game than the Pip 
Count.  Note: this assumes that none of your blots will be hit before bearing off. Can be 
displayed by pressing on the R key or by clicking when the cursor becomes a R when moved over the
bottom of the board frame (on the right side).

Runners  The two pieces that are farthest out at the start of the game (opponent’s 1 point). Also 
called Back Men.

Running Game  a game strategy where the player tries to get his pieces into his inner board as fast as
possible. Should only use when you have a significant lead in the pip count or you have completely 
passed each others pieces.

Triple Game  see Backgammon 
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Reporting Problems With The Game and Suggestions 

If you find a problem with the game please let me know so that it can be fixed. Even if there is not a 
problem but you have a suggestion for a new feature or a way to improve game play please let me 
know.

If you experience a problem with the game I need as much info as possible so that I can duplicate the 
problem. There are several of the ways to give me the information:

- Jot down a description of the problem, giving as much information as you can. The more the better.

- Save Game - save the game if possible and send it on a disk or as an attachment with an e-mail.

- Print Game - print the game and send it.
  
When the problem is fixed I will send you a fixed version of the game.

If your suggestion is included in a future version of the game I will give you a free copy with the 
game with the new feature/option. In most cases you will need to be a registered user to get a free 
upgrade.
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Quick Play Instructions       

Note: Click is short for saying press the left mouse button.

Direction of Play and Piece Color - at the start of the game, an arrow in one of the upper corners of 
the board shows your direction of play and your piece color.  Your dice are on the 
right side of the board.

General Play Summary

1 - Roll the dice by clicking on one of the dice
2 - Select the piece to move by clicking on the piece to be moved
3 - Select the destination by clicking on the row you want your piece on
4 - Double your opponent by clicking on the Cube
5 - Bear-off a piece by selecting the piece, then click on your tray (tray with the same piece

color at the end)
6 - Take back a move by clicking on the word BAR or by selecting the last piece moved and 

putting it back. 
7 - De-Select a piece by clicking on the row the piece came from or click on the word BAR
8 - Can’t use both dice - click on the dice to continue play

Computer Opponent Summary

1 - Select Computer Opponent in the Game menu
2 - See the General Play Summary

Human Opponent Summary

1 - Select Human Opponent in the Game menu
2 - Enter your names when requested, then press Return/Enter key
3 - See the General Play Summary

Select Show Possible Moves to have the game show which moves are possible when a piece is 
selected.

Get context sensitive help by clicking the right mouse button or the F1 key.

Want Information -- Run the cursor over the bottom section of the board frame. Click when the 
cursor turns to the appropriate letter. P for Pip Count, R for Remaining Rolls, etc....  Reference 
Helpful Information

Note: You can pick up more than 1 piece at once if Pick UP Only 1 Piece is not seleceted.
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